Database Programming: Tutorial 3

Data Presentation Using the DataGrid Control 
In this tutorial, you will learn how to:

· Create a data grid object on a Windows Form and use it to display database records.

· Sort database records by column.

· Change the format and color of cells in a data grid.

· Permit changes in data grid cells and write updates to the underlying database.

In previous tutorials, you learned how to use Microsoft ADO.NET database programming techniques to establish a connection to a Microsoft Access database and display fields from the database on a Windows Form. You also learned how to add navigation buttons such as First, Last, Prev, and Next to the form to provide a mechanism for browsing through the records of the database. In this chapter, you’ll continue working with the database programming features of Microsoft Visual Basic .NET and the useful classes and objects in ADO.NET. In particular, you’ll learn how to use the DataGrid control, which allows you to present several fields and records of a database at once.

Using DataGrid to Display Database Records 

The DataGrid control presents information by establishing a grid of rows and columns on a form to display data as you might see it in a program such as Microsoft Excel or Microsoft Access. A DataGrid control can be used to display any type of tabular data: text, numbers, dates, or the contents of an array. In this chapter, however, you’ll focus on DataGrid’s ability to display the fields and records of the Students.mdb database. You’ll start by filling a simple data grid object with text from the database, and then you’ll set a few formatting options. Next you’ll move on to sorting records in the data grid object and learning how to write changes in the data grid back to the underlying database.

The DataGrid control is connected, or bound, to database information through the DataGrid’s DataSource and DataMember properties. These properties will contain useful information only after your program has established a connection to a valid data source by using a data adapter and a dataset object. (The tools and processes involved in this connection were described in detail in the previous tutorials. Once a data grid object is bound to a valid data source, you can populate the object by using the Fill method of the data adapter object. The syntax for the Fill method looks like this:

OleDbDataAdapter1.Fill(DsInstructors1)

The following exercises demonstrate how you can display the Instructors table of the Students.mdb database by using a data grid object.

Establish a connection to the Instructors table

1. Start Microsoft Visual Studio .NET, and create a new Visual Basic Windows Application project named My DataGrid Sample in the c:\vbnet03sbs\chap20 folder.

A new project appears in the development environment.

2. On the View menu, click the Server Explorer command.

The Server Explorer window opens in the development environment. If you just completed the exercises in Chapter 19, there’ll be a current connection to an Access database named Students.mdb in Server Explorer under the Data Connections node. If there’s a red “x” on the connection, it means that the connection isn’t current, but if you click the ACCESS node, it should reestablish itself.

NOTE 
If you see a valid connection to the Students.mdb database now, don’t complete steps 3–7 that follow. Steps 3–7 are only necessary if you don’t see a valid database connection now. If you see a valid database connection, continue working at step 8.

3. Click the Connect To Database button in Server Explorer.

As you learned previously, the Connect To Database button helps you establish a connection to a database in your program.

4. Click the Provider tab in the Data Link Properties dialog box, and then click the entry Microsoft Jet 4.0 OLE DB Provider.

5. Click the Next button to display the Connection tab of the Data Link Properties dialog box.

In this tab, you’ll specify the name and location of the Access database that you plan to use—Students.mdb.

6. Click the ellipsis button next to the Select Or Enter A Database Name field, select the Students.mdb database in the c:\vbnet03sbs\chap19 folder, and click Open.

7. Click OK in the Data Link Properties dialog box.

Visual Studio completes your connection and adds a node representing your database to Server Explorer.

8. Expand the Data Connections node, the ACCESS node, and then the Tables node in Server Explorer by clicking the plus signs (+).

The structure of the Students database appears in Server Explorer, as shown here:
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Now you’ll create a data adapter for the Instructors table in the database.

9. Open the Toolbox, click the Data tab, and then drag the OleDbDataAdapter control to the form.

When you drag the control to your form, Visual Studio starts the Data Adapter Configuration Wizard.

10. Click the Next button to accept the opening screen.

11. Make sure your data connection to Students.mdb is selected in the Choose Your Data Connection dialog box, and then click Next.

12. Make sure the Use SQL Statements option is selected in the Choose A Query Type dialog box, and then click Next.

You’ll see a dialog box prompting you for a valid SQL SELECT statement.

13. Type the following SELECT statement in the text box:


SELECT


    Extension, 


    Instructor, 


    InstructorID, 


    PhoneNumber


FROM

    Instructors

This statement will retrieve the Extension, Instructor, InstructorID, and PhoneNumber fields from the Instructors table of the Students.mdb database and load them into your data adapter.

Your dialog box will look like this:
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14. Click the Next button to view the wizard results.

The wizard should have successfully created the appropriate SQL statements (SELECT, INSERT, UPDATE, and DELETE) and table mappings. If there are any errors, click the Back button and verify that your SQL statement is correct.

15. Click the Finish button to add the completed data adapter and connection objects to the component tray beneath your form. If you’re asked whether you want to include a password in the connection string you’ve created, click No.

A password isn’t necessary in this sample application, but you might want to use one in future database applications as a protection mechanism. Now you’ll create a dataset object to represent the Instructors table in your program.

16. Click the form to make sure that it’s active, and then click the Generate Dataset command on the Data menu.

The Generate Dataset dialog box appears.

17. In the New box, set the name of the new dataset to DsInstructors.

Verify that the Add This Dataset To The Designer check box is selected so that Visual Studio will add the new dataset to the component tray.

18. Click OK to create a dataset for the Instructors table and add it to your project.

The dataset appears in the component tray with the connection and data adapter objects, as shown here:

[image: image3.png]Start Page  Form1.vb [Design]* |

TR 0]

B ODbDatoAdeptert B OkDbComectiont | SDsinstrucirst





Now that you’ve established a connection to the Instructors table, you’re ready to display the records by using a DataGrid control.

Create a data grid object

1. Resize the form so that it’s large enough to display 4 columns and about 10 rows of data.

2. Click the Windows Forms tab in the Toolbox, and then click the DataGrid control.

3. Create a large data grid object on the form with the DataGrid control.

4. Add a Button control below the data grid.

Your form should look like this:
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5. Click the data grid on the form, and then open the Properties window.

6. Set the Anchor property to all four sides, as shown here:
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Now you’ll use the DataSource and DataMember properties to bind the data grid object to the DsInstructors1 dataset.

7. Display the DataSource property options in the Properties window.

The DataSource property contains the name of the dataset you’re displaying in the data grid. Remember that there can be more than one active dataset in a program, so you might have more than one selection here.

8. Click the DsInstructors1 dataset (not the DsInstructors1.Instructors entry).

The Properties window looks like the following illustration as you pick the DsInstructors1 dataset:
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Now you’ll use the DataMember property to specify the sublist (in this case, the table) that you want to display in the data grid.

9. Click the DataMember property, and then click the Instructors entry.

As soon as you specify the DataMember property, a grid appears in the data grid object containing the fields you specified in the Instructors table. The fields appear as columns in the grid, and a row is reserved for the first record in the dataset. When you run your program and populate the data grid with data, the specific records in the Students.mdb database will also be added to this grid.

10. Click the form and set its Text property to “DataGrid Sample”.

11. Click Button1 on the form, set its Anchor property to Bottom, Left, set its Name property to btnLoad, and then set its Text property to Load.

Your form should look like this:
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Now you’ll add the program code necessary to populate the data grid. You’ll add the Fill method to the btnLoad_Click event procedure.

12. Double-click the Load button to display the btnLoad_Click event procedure.

13. Type the following program statements:


DsInstructors1.Clear()


OleDbDataAdapter1.Fill(DsInstructors1)

The Clear method makes sure that no records are present in the dataset from previous queries—it clears the dataset out and prepares it for new data. The Fill method fills the dataset with data from the DsInstructors1 dataset—data from the Instructors table of the Students.mdb database.

14. Click the Save All button on the toolbar to save your changes.

You’re ready to run the program.

15. Click the Start button on the Standard toolbar.

16. Click the Load button.

The data grid object is populated with data from the dataset. Your screen will look like this:
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Each row in the grid represents a record of data from the Instructors table in the database. The SELECT statement that we used included all the fields (columns) in the Instructors table, but we could have easily limited the number of fields so that the entire table isn’t currently visible or included in the dataset. Notice that the fields are organized in the order you placed them in your SELECT statement—you can change this order by placing the fields in the SELECT statement in a different sequence. Also note that scroll bars appear so that you can view any records that aren’t immediately visible. This is a handy ease-of-use feature that comes automatically with the DataGrid control.

17. Scroll down the list of records to view all the database information, which represents instructor data for a college or university.

18. Resize the form to see more of the instructor data.

Because you set the Anchor property for the data grid and the button, their size and position adjust accordingly.

Note that you can widen the columns of the data grid (to see their entire contents) by dragging the column cell borders to the right. The following illustration shows what the data grid looks like after the Instructor column has been widened:
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You can also take advantage of an automatic sorting feature of the DataGrid control when it’s filled with data.

19. Click the Instructor column heading.

The data grid is sorted alphabetically by instructor name. (Barr, Adam is now first.) When database records are sorted, a sorting column, or key, is required—you establish this key by clicking on the column heading that you want to use for the sort.

The DataGrid provides visual identification for the current sort key—a tiny arrow to the right of the column header. If the arrow is pointed up, the sort order is an alphabetical A–Z list. However, you can click the column heading again and reverse the sort order, making it an alphabetical Z–A list. The arrow acts like a toggle, so you can switch back and forth between sorting directions.

TIP 
Sorting is only allowed in the DataGrid control if the AllowSorting property is set to True, its default setting. If you don’t want to allow sorting, set this property to False at design time.

20. Click the Instructor column several times to see how the sort order can be switched back and forth.

21. Click other column headings such as InstructorID and PhoneNumber to sort the database by those keys.

22. When you’re finished experimenting with the scrolling, resizing, and sorting features of the DataGrid control, click the Close button on the form to stop the program.

The program closes, and the development environment returns.

Well done…but you’re not finished just yet!
Formatting DataGrid Cells 

You can control the look and orientation of several DataGrid characteristics with property settings at design time to customize the appearance of your dataset on the form. For example, you can change the default width of cells in the grid, add or remove column headers, change the grid or header background colors, and change the color of the gridlines. The following exercise steps you through some of these useful property settings.

Set data grid properties at design time

1. Display the form and click the data grid object, and then open the Properties window.

2. Set the PreferredColumnWidth property to 110.

A setting of 110 (measured in pixels) will provide enough room for the data in the fields in the Instructors table.

3. Set the ColumnHeadersVisible property to False.

This property setting will remove the field names from the table. This is useful if the field names in your database don’t clearly identify their contents or if the field names contain abbreviations or words that you want to hide from your users.

4. Click the BackColor property, click the drop-down arrow, click the Custom tab, and then select the light yellow color for the cells of the data grid.

The BackColor property controls the color that appears in the background of the data grid cells. If you change this setting, it will usually produce an alternating effect (white and the color you select) from row to row in the data grid. (Note that the color that appears around the edges of the cell grid is controlled by the BackgroundColor property.) Remember that the default font color is black, so pick a background color that will look good with black if you change this setting. (Don’t get carried away with distracting colors if you change the property from its default value.)

TIP 
To change the background color used for the header cells, modify the HeaderBackColor property.

5. Click the GridLineColor property, click the drop-down arrow, click the Custom tab, and then click Blue.

This property setting sets the color of the gridlines in the data grid. If you change the background color of the cells, you might also want to modify the gridline color.

Now run the program to see the effect of your formatting changes.

6. Click the Start button.

7. Click the Load button.

After a few moments, the data grid appears with information from the Instructors table.

8. Resize the form to accommodate the wider columns.

Your screen will look like this:
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Notice that the column headers are missing now but that the cells are wider and contain more room for text. Notice also the alternating yellow and white row pattern and the blue gridlines (not discernible in this book, alas, but on the screen).

9. Click the Close button on the form to stop the program.

Scan the Properties window for additional property settings and customizations—there are several possibilities if you look closely at the list of formatting options.

One Step Further: Updating the Original Database 

As  mentioned earlier, the dataset object in your program is only a representation of the data in your original database. This is also true of the information stored in the data grid on your form—if the user makes a change to this data, it isn’t written back to the original database unless you specifically direct the data adapter object in your program to make the change. The designers of ADO.NET and Visual Studio created this relationship to protect the original database and to allow you to manipulate data freely in your programs—whether you planned to save the changes or not.

In the following exercise, you’ll examine the DataGrid ReadOnly property, which enables or disables changes in the data grid. You’ll also learn how to use the Update method, which writes changes back to your original database on disk if you need this feature.

Enable updates to the database

1. Click the data grid object on the form, and then open the Properties window.

2. Scroll to the ReadOnly property, and examine its property setting.

If the ReadOnly property is set to False, the user is free to make changes to the information in data grid cells. You should keep this default setting if you want to allow your users to modify the information in the data grid so that it can be written back to the original database your program is connected to. If you want to disable editing, you would set the ReadOnly property to True.

Keep the default setting of False in this case—you want to test updating the underlying Students.mdb database.

3. Use the Button control to draw a button object near the bottom of the form.

4. Set the Anchor property of the button object to Bottom, Left, set the Name property to btnUpdate, and set the Text property to Update.

This is the button the user will click when he or she makes a change and wants to pass it to the underlying database.

5. Double-click the Update button, and then type the following program code in the btnUpdate_Click event procedure:


Try


    OleDbDataAdapter1.Update(DsInstructors1)


Catch ex As Exception


    MsgBox(ex.ToString)


End Try

This program statement uses the Update method of the OleDbDataAdapter1 object to write any changes that have been made in the DsInstructors1 dataset. When you make a change to the data grid, the data grid object automatically updates the dataset to which the data grid is bound. However, you need to take the further step of updating the data adapter in the program if you want to write the change all the way back to the underlying database.

6. Click the Start button to test your addition to the DataGrid Sample program..

7. Click the Load button.

The data grid appears with data from the Instructors table of the Students.mdb database.

8. Resize the form, and change the contents of one of the data grid cells by selecting the existing value with the mouse, pressing Delete, and then typing a new value.

As you make the change, a tiny pencil icon appears in the left row header, indicating that a change is being made. Your screen will look like this:
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When you click a different cell in the grid, the change is written to the DsInstructors1 dataset.

9. Click the Update button.

Visual Basic uses the Update method of the program’s data adapter object to write the changed dataset to the underlying database. The Students.mdb database is now permanently changed.

10. Click in a cell of the last row, which has a star icon in the left row header.

11. Modify the cells that have “(null)” values.

A new row appears in the grid.

12. Click the Update button.

A new row is permanently inserted in the Instructors table of the Students.mdb database.
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13. Click the left row header of the row you just inserted to select the entire row, and then press the Delete key.

The row is deleted.

14. Click the Load button.

The deleted row reappears. Why is this? Didn’t you just delete the row? The row was deleted from the DsInstructors1 dataset, but the row still exists in the Students.mdb database. To permanently delete a row, you’ll need to click the Update button to update the underlying database.

15. Make a few additional changes if you like, and then close the program when you’re finished.

Congratulations! You’ve learned to display several fields and records by using the DataGrid control, and you’ve learned how to customize the data grid with property settings and how to write updates in the grid back to the original database. If you want to learn more about ADO.NET programming, consult one of the books or resources listed in the Appendix.
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